## Contents

   1.1. Creating an Azure Account.................................................................................................................. 3
   1.2. Licensing Intel FPGA Software for the Azure Cloud........................................................................ 3
   1.3. Licensing IP Cores............................................................................................................................ 3
   1.4. Managing Intel FPGA Software on the Azure Cloud...................................................................... 4
      1.4.1. Signing In the Azure Web Portal............................................................................................... 4
      1.4.2. Selecting Intel FPGA Tool from the Azure Marketplace............................................................ 4
      1.4.3. Specifying the Virtual Machine Characteristics........................................................................ 5
      1.4.4. Launching the Virtual Machine.................................................................................................. 8
      1.4.5. Connecting to the Azure Virtual Machine Using SSH............................................................... 11
      1.4.6. Obtaining a GUI Desktop on the Running Azure Virtual Machine.......................................... 12
      1.4.7. Opening the Intel Quartus Prime Software................................................................................ 13
      1.4.8. Terminating the Virtual Machine............................................................................................. 14
   1.5. Persistent Storage and Data Transference...................................................................................... 15
   1.6. Hosting a License Server in the Microsoft Azure Cloud...................................................................... 15
      1.6.1. Create a License Server Machine in the Azure Cloud................................................................. 16
      1.6.2. Upload the Flexlm License Server to the Server Machine............................................................ 16
      1.6.3. Configure and Start the License Server..................................................................................... 18
      1.6.4. Manage the License Server...................................................................................................... 19
   1.7. Connecting to the License Server.................................................................................................... 19
      1.7.1. Preserving the MAC Address.................................................................................................. 20
   1.8. Example: Running Intel Quartus Prime Design Space Explorer II............................................. 20
      1.8.1. Starting Intel Quartus Prime Design Space Explorer II.............................................................. 20
      1.8.2. Setting Up an Intel Quartus Prime Project.................................................................................. 21
   1.9. Example: Running the "Hello World" Program Using the Intel FPGA SDK for OpenCL............. 25


This user guide describes how to run Intel® Quartus® Prime Pro Edition and Intel FPGA SDK for OpenCL™(1)(2) using the Azure* Cloud platform. The Microsoft* Azure Platform offers compute, networking, storage and other services.

You can learn about the available licensing models, how to create an account, how to transfer files to and from your account, and how to manage the lifecycle of your virtual machines. The last sections of this user guide show examples of using Intel Quartus Prime Design Space Explorer II, and the Intel FPGA SDK for OpenCL.

Note: This document assumes a basic understanding of authentication using SSH standards for Secure Shell.

1.1. Creating an Azure Account

To use Microsoft Azure cloud resources you must create an Azure account, or subscription. With your account, you can launch Intel FPGA tools from the Azure Marketplace and run them on Azure virtual machines.

• Sign-up for Microsoft Azure at: https://azure.microsoft.com/

1.2. Licensing Intel FPGA Software for the Azure Cloud

The Intel FPGA software supports the Pay-As-You-Go licensing model in the Azure cloud. This model charges a flat rate per each minute the machine is running. The rate depends on the machine characteristics.

1.3. Licensing IP Cores

If the IP cores in your design require licensing, use the Bring-Your-Own-License (BYOL) licensing model. This model requires you to host the license on a server. You can either use your own server, or create a license server in the Azure cloud.

Related Information
Hosting a License Server in the Microsoft Azure Cloud on page 15

(1) The Intel FPGA SDK for OpenCL is based on a published Khronos Specification, and has passed the Khronos Conformance Testing Process. Current conformance status can be found at www.khronos.org/conformance.

(2) OpenCL and the OpenCL logo are trademarks of Apple Inc. used by permission of the Khronos Group™.
1.4. Managing Intel FPGA Software on the Azure Cloud

A typical session of Intel FPGA software on the Azure Cloud follows a distinct sequence:

1. Signing In the Azure Web Portal on page 4
2. Selecting Intel FPGA Tool from the Azure Marketplace on page 4
3. Specifying the Virtual Machine Characteristics on page 5
4. Launching the Virtual Machine on page 8
5. Connecting to the Azure Virtual Machine Using SSH on page 11
6. Obtaining a GUI Desktop on the Running Azure Virtual Machine on page 12
7. Opening the Intel Quartus Prime Software on page 13
8. Terminating the Virtual Machine on page 14

1.4.1. Signing In the Azure Web Portal

1. Visit the Azure platform page at: https://portal.azure.com/
2. Sign into your account.
   A successful sign in takes you to the Azure Dashboard page.

Related Information
Creating an Azure Account on page 3

1.4.2. Selecting Intel FPGA Tool from the Azure Marketplace

Select the Intel FPGA application that you want to run.
1. In your account’s Dashboard page, click + New to open the Azure Marketplace.
2. Type Intel FPGA on the search filter.
3. Click the Intel FPGA application.
4. In the tab that opens, click **Create**.

**Figure 2. Azure Marketplace**

The **Create Virtual Machine Basics** form appears.

**1.4.3. Specifying the Virtual Machine Characteristics**

Specify instance type, launch time settings, and other optional parameters of the virtual machine.
1.4.3.1. Basic Settings

Specify the basic settings. When you finish, click OK to move to the next step.

1. In your local machine, create a SSH key pair to use as authentication method.
   
   For information about creating SSH keys, refer to the Microsoft Azure Documentation.

2. In the Basics pane, specify the following parameters:

Table 1. Virtual Machine Basic Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the machine.</td>
</tr>
<tr>
<td>VM Disk Type</td>
<td>Select SSD (solid state drive). This option offers faster performance.</td>
</tr>
<tr>
<td>User Name</td>
<td>Administrator name on the virtual machine. You use this name to connect to the machine.</td>
</tr>
<tr>
<td>Authentication type</td>
<td>Authentication method to connect to the machine.</td>
</tr>
<tr>
<td></td>
<td>• Select SSH public key, and type or paste the public key that you created.</td>
</tr>
<tr>
<td>Subscription</td>
<td>Which Azure account to use.</td>
</tr>
<tr>
<td>Resource group</td>
<td>Resource group associated to the virtual machine. You can create a new resource group or use an existing one. Resource groups are mandatory, and help you organize and locate resources.</td>
</tr>
<tr>
<td>Location</td>
<td>Azure datacenter of the machine. Select the datacenter that is closest to you for lowest latency.</td>
</tr>
</tbody>
</table>

Figure 3. Virtual Machine Basic Settings

Related Information

- How to Use SSH keys with Windows on Azure
  In Microsoft Azure Documentation
- How to create and use an SSH public and private key pair for Linux VMs in Azure
  In Microsoft Azure Documentation
- Persistent Storage and Data Transference on page 15
1.4.3.2. Machine Size and Instance Type

Each machine instance type specifies the memory size and number of CPU cores of the virtual machine.

1. Click **View All** to view all the machines available.

2. Find a server size that meets the physical memory requirements for the device family. The Azure Memory-Optimized EV3 series has instance types with high memory capacity.

In the Intel Quartus Prime Pro Edition software version 17.1, memory requirements for Intel Arria® 10 devices range from 18 GB to 48 GB. Intel Stratix® 10 memory requirements range from 80 GB to 128 GB. For information about other devices, refer to Intel Quartus Prime Pro Edition Software and Device Support Release Notes.

**Note:** Machine availability varies with the location of the Azure datacenter. If the instance type that you want is not available in the current location, select a different location.

3. Click **Select**.

**Note:** In the Intel Quartus Prime software, using a machine with a higher number of processors can reduce compilation time. To take advantage of this, specify the number of processors for compilation. For more information, refer to Enabling Multi-Processor Compilation in Intel Quartus Prime Pro Edition Handbook Volume 1.

**Related Information**

- **Memory Recommendations**
  - In Intel Quartus Prime Pro Edition Software and Device Support Release Notes
- **Enabling Multi-Processor Compilation**
1.4.3.3. Network Settings

These settings allow you to enhance the security of the virtual machine.

1. In the **Optional Settings** pane, specify:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual network</td>
<td>Select the virtual network to place the machine. If you do not select a virtual network, Azure generates one, with default security settings. Important: You can increase the security settings by restricting SSH access to known IP addresses, or by disabling SSH access and using a bastion host. For information about creating a Virtual Network, refer to the Azure documentation.</td>
</tr>
<tr>
<td>Subnet</td>
<td>Select a section of the virtual network to place on the machine. Machines on the same subnet can access each other.</td>
</tr>
<tr>
<td>Public IP address</td>
<td>Specify the public DNS name for this machine. You can create a new, select any existing Public IP address resource, or select None.</td>
</tr>
<tr>
<td></td>
<td>• If you select None, you must reach the new machine through a bastion host.</td>
</tr>
<tr>
<td></td>
<td>• If you create a new IP address, you can select Dynamic or Static. Dynamic IP changes each time that the VM stops or restarts.</td>
</tr>
<tr>
<td>Network security group (firewall)</td>
<td>Specify the type of network traffic allowed to reach the machine.</td>
</tr>
<tr>
<td></td>
<td>a. Click the entry.</td>
</tr>
<tr>
<td></td>
<td>b. Select the Choose network security group panel.</td>
</tr>
<tr>
<td></td>
<td>c. Create a new group or specify an existing one. If you don't select a security group, Azure generates one that allows connection requests from any IP. Important: Intel recommends creating security rules in the network security group. For information about creating a network security group, refer to the Azure documentation.</td>
</tr>
<tr>
<td>Auto-shutdown</td>
<td>This option enables machine to automatically shutdown at a specific time. This feature is useful if you do not use the machine after office hours. To activate this feature:</td>
</tr>
<tr>
<td></td>
<td>a. Click On.</td>
</tr>
<tr>
<td></td>
<td>b. Specify the Shutdown time and time zone.</td>
</tr>
</tbody>
</table>

2. Click **OK** to see the summary of settings.

*Note:* You can also click **Download template and parameters** to store the image settings to a file for later use.

**Related Information**

- Azure Virtual Network
  In Microsoft Azure Documentation
- Filter network traffic with network security groups
  In Microsoft Azure Documentation

1.4.4. Launching the Virtual Machine

1. At the bottom of the Summary of Settings, click **Create** to launch the virtual machine.
2. In the left menu, click **Virtual Machines** to monitor the deployment progress.
When the machine is ready, the **Status** appears as **Running**.

3. Click the running machine to display details.

**Figure 7. Virtual Machine Details**

4. Copy the **Public IP Address** number.
   
   You need the IP address to connect to the machine. Optionally, you can configure a DNS name for the machine.

**Related Information**

**Managing Linux Virtual Machines**

In Microsoft Azure Documentation
1.4.5. Connecting to the Azure Virtual Machine Using SSH

To connect, use the following parameters:

<table>
<thead>
<tr>
<th>Table 3. Parameters to connect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>User Name</td>
</tr>
<tr>
<td>Machine IP address</td>
</tr>
</tbody>
</table>

If you network uses a proxy, get the following details from your system administrator:
- Proxy type
- Proxy hostname
- Proxy port

Related Information
Basic Settings on page 6

1.4.5.1. Connecting from a Windows* Computer

To connect to a running Azure Virtual Machine from a Windows* computer:
1. Start PuTTY.
2. In the Host field, type one of the following:
   - <username>@<Machine-DNS-name>
   - <username>@<Machine-IP-address>
3. If you use a proxy, specify the proxy details in Connection ➤ Proxy. Type proxy type, hostname, and port.
4. If you want to use the session again, create a name for the session in Saved Sessions and click Save. You can later select from the list of saved sessions.
   You can reuse a saved session with other virtual machines by changing the machine IP address or DNS name. The rest of the information remains the same.
5. Press Open to connect.

The first time PuTTY connects to a machine, a warning appears, stating that the host key is not cached, and displays machine’s rsa2 fingerprint. Click Yes to accept.

1.4.5.2. Connecting from a Linux Computer

To connecting to a running Azure virtual machine from a Linux computer:
- In a terminal, type:
  
  ```bash
  ssh -i <mysshkey> -l <admin username> <public dns or ip address>
  ```

  Note: If your network uses a proxy, ask your system’s administrator for the ssh connection syntax.
1.4.6. Obtaining a GUI Desktop on the Running Azure Virtual Machine

After establishing a connection to the virtual machine using SSH, you can obtain a GUI desktop.

1. In a terminal connected to the remote machine, type:
   
   /opt/intelFPGA_pro/<release-number>/cloud/setup_vncserver.sh

   The script shows a list of display resolutions.

2. Select a display resolution.

3. Create and type a VNC password.
   
   Notice: You use this password later when you start the VNC session.
   
   The script starts a VNC Server on localhost:5901

4. On your local machine, configure the SSH session to forward to source port 5300(1) to destination localhost:5901.
   
   This action makes the connection more secure, because the only way to connect to the machine is through a secured SSH tunnel.
   
   — Windows: Setup PuTTY’s tunnel (In SSH ➤ Tunnels) to enable local ports accept connections from other ports and Forward ports.

   Source port      5300
   Destination      localhost:5901

   — Linux:

   ssh -i mysshkey -l <admin-username> 
   -L 5300:localhost:5901 <public-dns-or-ip-address>

5. Start VNC Viewer in your local computer, and connect to server on localhost:5300
   
   A successful connection opens a desktop view of the machine.

(1) If another VNC session or application is using the port 5300, substitute for a different port.
1.4.7. Opening the Intel Quartus Prime Software

To open the Intel Quartus Prime software from your VNC desktop:

1. In the virtual desktop, open a terminal by clicking **Applications ➤ System Tools ➤ Terminal**.

2. In the terminal, type:

   `quartus &`

   The Intel Quartus Prime software opens.
1.4.8. Terminating the Virtual Machine

After finishing your Intel FPGA session, you can terminate the virtual machine. This action stops the billing, helping you keep costs low.

**Note:** When your virtual machine terminates, all files are lost. Save the data you want to keep in the persistent storage. For more information, refer to *Persistent Storage and Data Transference*.

To terminate your virtual machine from the Azure Portal:
1. In the left menu, click **Virtual Machines**.
2. From the list, select the virtual machine you want to terminate, and click **Delete** in the top menu.

3. Delete the resources connected to this virtual machine. These resources include Network interface, Disk, and Public IP address.

   **Note:** The name of the resources connected to a machine use the machine name as a prefix.

If you click **Stop** instead of **Delete**, you save the state of your machine, and you can resume your work by restarting the machine. During the time the machine is in **Stop** status you only pay for the storage.

**Related Information**

*Persistent Storage and Data Transference* on page 15
1.5. Persistent Storage and Data Transference

An Azure machine has two types of storage: Local storage and managed disk.

Local storage is available on /mnt/resources, and is physically attached to the machine. When you stop the machine, the data in /mnt/resources is removed.

Managed disk is available in /dev/sda, and contains two partitions: /opt is mounted on the /dev/sda2 partition, and contains the installation of Intel FPGA software.

The root directory / is mounted on /dev/sda1 and has 30GB of storage. You cannot expand /dev/sda1.

- To add more disk space to the OS disk, you can update the size of the disk, create a new partition, and mount the partition on a directory under / such as /mydata.
- To share storage among multiple virtual machines, or with machines on premise, use one of the following methods:

<table>
<thead>
<tr>
<th>File Sharing Method</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Copy Protocol</td>
<td>For information about using the Secure Copy Protocol with Azure machines, refer to the Microsoft Azure Documentation.</td>
</tr>
<tr>
<td>Windows</td>
<td>sc (PuTTY)</td>
</tr>
<tr>
<td>Windows (PuTTY)</td>
<td>pscp</td>
</tr>
<tr>
<td>Azure File Share</td>
<td>For information about Azure File Share, refer to the Microsoft Azure Documentation.</td>
</tr>
<tr>
<td>Network File System</td>
<td>NFS</td>
</tr>
<tr>
<td></td>
<td>Allows you to share a directory for all your machines. For information about NFS, refer to Configure shared storage and move database files in the Microsoft SQL Documentation.</td>
</tr>
</tbody>
</table>

Related Information

- Move files to and from a Linux VM using SCP
  In Microsoft Azure Documentation
- Introduction to Azure Files
  In Microsoft Azure Documentation
- Configure shared storage and move database files
  In Microsoft SQL Documentation

1.6. Hosting a License Server in the Microsoft Azure Cloud

To setup a license server in the Azure cloud:

1. Create a License Server Machine in the Azure Cloud on page 16
2. Upload the Flexlm License Server to the Server Machine on page 16
3. Configure and Start the License Server on page 18
4. Manage the License Server on page 19
1.6.1. Create a License Server Machine in the Azure Cloud

Create an Azure virtual machine to use as a license server.

1. In your local machine, create a SSH key pair to use as authentication method. For information about creating SSH keys, refer to the Microsoft Azure Documentation.

2. In the Azure marketplace, launch a virtual machine with CentOS 7 and specify the following parameters:

<table>
<thead>
<tr>
<th>Table 5. Virtual Machine Basic Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>VM Disk Type</td>
</tr>
<tr>
<td>User Name</td>
</tr>
<tr>
<td>Authentication type</td>
</tr>
<tr>
<td>Subscription</td>
</tr>
<tr>
<td>Resource group</td>
</tr>
<tr>
<td>Location</td>
</tr>
</tbody>
</table>

3. Under **Machine Size**, select the small A1 Basic instance type. If the demand increases, you can resize the machine to larger A series machine type.

4. Under **Network Settings**, select the same virtual network, subnet, and network security group as the images with Intel FPGA applications.

**Related Information**
- How to Use SSH keys with Windows on Azure
  In Microsoft Azure Documentation
- How to create and use an SSH public and private key pair for Linux VMs in Azure
  In Microsoft Azure Documentation
- Specifying the Virtual Machine Characteristics on page 5

1.6.2. Upload the Flexlm License Server to the Server Machine

To obtain and upload a license server installer in the Azure cloud:

1. On your local machine, visit:
   
   `dl.altera.com`

   You enter the Intel FPGA download page.
Figure 12. Intel FPGA Download Page

2. Specify the parameters for your download file:

Table 6. Download Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Edition</td>
<td>Pro</td>
</tr>
<tr>
<td>Select Release</td>
<td>17.1</td>
</tr>
<tr>
<td>Operating System</td>
<td>Linux</td>
</tr>
<tr>
<td>Download Method</td>
<td>Direct Download</td>
</tr>
</tbody>
</table>

3. Click the Additional Software tab.

4. Check Flexlm License Server Software.

5. Click Download Selected Files.

6. When the download completes, send the file to the VM:
1.6.3. Configure and Start the License Server

Set up the license server in the virtual machine:
1. Connect to the virtual machine using SSH.
2. From the virtual machine, configure the Flexlm license server to run as a Systemd service and start at boot:

   ```
sudo ./FlexlmSetup-<release> -linux.run -installdir /opt/intelFPGA_pro/<version>/flexlm -mode unattended
   
   ```
3. Get the MAC address of the license server:

   ```
   /opt/intelFPGA_pro/<version>/flexlm/bin/lmutil lmhostid
   
   ```
4. Regenerate your Intel Quartus Prime license for the license server from the Self Service Licensing Server.
   — You must log on your My Intel account.
   — For details on using the Self-Service Licensing Server, refer to the Intel FPGA Software Installation and Licensing.
5. When you receive the license file, follow the instructions in the email and customize the file.
6. Upload the file to the license server:
   — Linux:

   ```
   scp -i <private-key> <license>.dat <user>@<dns-or-ip-addr>/opt/intelFPGA_pro/<version>/flexlm/license.dat
   
   ```
   — Windows:

   ```
   pscp -i <private-key> <license>.dat <user>@<dns-or-ip-addr>/opt/intelFPGA_pro/<version>/flexlm/license.dat
   
   ```
To improve security, a non-root user runs the license server.
7. On the license server, create a user named flexlm:

   ```
   sudo adduser flexlm
   ```
8. Delete the password for the flexlm user:
   sudo passwd -d flexlm

   This action makes the user only available to root.

9. Give ownership of the Flexlm files to flexlm user
   sudo chown -R flexlm:flexlm /opt/intelFPGA_pro/<version>/flexlm/

10. Create a systemd init service unit to run the license service after booting the Linux kernel, Create a file named intelFPGA.service in /etc/systemd/system/
    A service unit file describes what process to run and how to manage it.

11. In the intelFPGA.service file, add the following content:

    ```
    [Unit]
    Description=Auto Start intelFPGA License Server
    
    [Service]
    Type=simple
    ExecStart=/usr/bin/su flexlm -c '/tools/intelFPGA_pro/<version>/flexlm/bin/lmgrd -c /tools/intelFPGA_pro/<version>/license.dat -z -l /tools/intelFPGA_pro/<version>/debug.log'
    Restart=always
    RestartSec=10
    
    [Install]
    WantedBy=multi-user.target
    ```

Related Information

**Setting Up Floating Network Licenses on the License Server**
In Intel FPGA Software Installation and Licensing

**1.6.4. Manage the License Server**

These commands perform common actions in the license server:

- **Start the license server:**
  sudo systemctl start intelFPGA

- **Query the license server status:**
  sudo systemctl status intelFPGA

- **Get detail information on the license server run:**
  /opt/intelFPGA_pro/17.1/lmutil lmstat

- **Stop the license server:**
  sudo systemctl stop intelFPGA

**1.7. Connecting to the License Server**

To connect the Intel FPGA tool to the License Server:
1. In the virtual machine with Intel FPGA software, type:

```plaintext
LM_LICENSE_FILE=<port>@<private-ip-address-of-license-server>
```

Intel FPGA software uses the `LM_LICENSE_FILE` variable to specify license location.

2. Optionally, in the Intel Quartus Prime software click **Tools ➤ License Setup**. This pane displays the IP cores that the licensing server enables.

If the connection to the server works, designs that use the licensed IPs compile successfully.

### 1.7.1. Preserving the MAC Address

The MAC Address of an Azure virtual machine derives from the Network Interface resource attached to the machine.

- If the machine stops and restarts, the MAC address persists.
- If the machine terminates and you want to launch a new machine using the same MAC address, you must attach the previous Network Interface to the new machine.

To replace a virtual machine's Network Interface:

1. From the Azure portal, select the license server's virtual machine.
2. Stop the virtual machine.
3. From the side menu, select **Networking**.
4. Click **Attach Network Interface** and select the original Network Interface.
5. Click **Detach Network Interface** and select the new Network Interface.

**Related Information**

- [Network Settings](#) on page 8
- [Create, change, or delete a network interface](#) in Microsoft Azure Documentation

### 1.8. Example: Running Intel Quartus Prime Design Space Explorer II

The Intel FPGA applications that you can use on the Azure Cloud include the Intel Quartus Prime Design Space Explorer II tool. This tool increases performance by automatically iterating through combinations of Intel Quartus Prime software settings to find optimal design results.

Intel Quartus Prime Design Space Explorer II works best on machines with many cores.

#### 1.8.1. Starting Intel Quartus Prime Design Space Explorer II

To start Intel Quartus Prime Design Space Explorer II, select a large instance with multiple CPU cores. The compilations run on the same machine and share the memory.
1. Select an instance type with enough memory for the desired parallelism.
   An Intel Arria 10 design requires about 50GB of RAM. To perform ten compilations in parallel, choose an instance type with sufficient memory and at least 10 cores.
   - The Microsoft Azure Memory-optimized Standard_E64_v3 instance type has 532GB RAM and 64 CPU cores.

2. Launch the job.

3. In the virtual desktop, open a terminal and type:
   ```
   quartus_dsew&
   ```
   Intel Quartus Prime Design Space Explorer II starts.

**Figure 13. Intel Quartus Prime Design Space Explorer II**

**Related Information**

Machine Size and Instance Type on page 7

1.8.2. Setting Up an Intel Quartus Prime Project

Prepare your project for compilation.

1. On the **Project** tab, click **Open Project**, and select an Intel Quartus Prime project.
   If you do not have an example at hand, copy an example from the $QUARTUS_ROOTDIR/qdesigns directory in your local folder.

2. Click the **Setup** tab. In **Compilation Type**, select **Local**.
3. On the Exploration tab, click to display Exploration Points. Specify the following settings:

**Table 7. Settings for Exploration Points in Design Space Explorer II**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explore</td>
<td>Select Design Exploration.</td>
</tr>
<tr>
<td>Skip base exploration point</td>
<td>Enable to avoid performing a base compile with no seed or assignment changes.</td>
</tr>
<tr>
<td>Exploration Mode</td>
<td>Select Seed Sweep Only.</td>
</tr>
<tr>
<td>Seeds</td>
<td>Select Specify, and specify a range of seeds to test out.</td>
</tr>
</tbody>
</table>
4. To configure parallelism, click **Advanced**. Specify the following settings:

### Table 8. Advanced Settings for Design Space Explorer II

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum parallel compilations</td>
<td>In the example with Intel Arria 10 and instance type Standard_E64_V3, enter 10.</td>
</tr>
<tr>
<td>Maximum number of CPUs</td>
<td>Number of CPUs each compiler must use. Since 10 compilers share the CPUs, divide the number of CPU cores by the number of compilers. The Standard_E64_V3 machine has 64 cores and 512 GB of physical RAM, so for the Intel Arria 10 example you use 6 CPUs per compiler.</td>
</tr>
</tbody>
</table>
On warning about performing more than one compilation simultaneously, click **OK**.
Your project is ready for compilation.

5. To compile, click **Start**.

---

**Figure 16. Advanced Settings in Exploration Tab**

**Figure 17. Start Compilation**
1.9. Example: Running the "Hello World" Program Using the Intel FPGA SDK for OpenCL

If you are new to the Intel FPGA SDK for OpenCL, use the "Hello World" example included in the Intel FPGA software installation as a starting point.

To set up the "Hello World" example:
1. In the virtual desktop, open a terminal by clicking **Applications ➤ System Tools ➤ Terminal**.

   **Figure 18.** Open Terminal in Azure Virtual Desktop

2. Copy the example folder from the Intel FPGA software installation to the `/data` directory. In the terminal, type:
   ```bash
   cp -r $INTELFPGA_ROOTDIR/examples/opencl ~/ 
   
   The example files are now in the `~/opencl` folder.
3. With a web browser, open the README.html file. Follow the instructions to run the "Hello World" example.
Figure 20. Terminal After Executing the "Hello World" Example

To find more examples of using Intel FPGA SDK for OpenCL, go to the Developer Zone in the Altera website.

Related Information

- Developer Zone
- Getting Started with the Intel FPGA SDK for OpenCL for Linux
  In Intel FPGA SDK for OpenCL Getting Started Guide

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017.12.22</td>
<td>17.1.0</td>
<td>Initial release of the document.</td>
</tr>
</tbody>
</table>